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EDITOR’S NOTES 
 
Windows 11 upgrade 
Upgraded from Windows 10 Home to Windows 11 Home on Lenovo laptop computer. Total time from 
download to completion about an hour and a half. No issues. When lock screen displayed, took several 
minutes before mouse was available, either from computer trackpad or Bluetooth mouse. Have multiple 
user accounts on computer. Ran install from Admin account. When install completed, logged into Admin 
account and no additional setup. Logged out of Admin account and into other accounts and it completed 
user install for each additional user.   
 
After update, there were some system related updates available, Realtek, Fortemedia, Lenovo System, 
Dolby. There was no specific detail on those updates. Installed those updates, then installed Windows 11 
Cumulative Update 02-2022.  
 
Hoping to demo Windows 11 at February Zoom meeting.  
 
Email supposedly from Norton regarding renewal 
Email indicated from NortonLLC / quickbooks@notification.intuit.com 
Subject: Invoice 2640 has been renewed Now amount will be charge in 2 hours 
 
Don’t have Norton or Intuit so was immediately suspicious.  
 
Although it looks like a valid email, it is a scam 
https://community.norton.com/en/forums/norton-antivirus-scam  

 
SPAM RISK showing on telephone caller id 
Receiving calls with caller id SPAM RISK on landline phone (Spectrum service).  
 
Generally calls showing SPAM RISK don't leave a voicemail message or it is a blank message. Recently 
had two separate calls indicating SPAM RISK with voicemail message and both were automated 
messages from valid companies.  
 
Not sure how SPAM RISK id is added, whether by Spectrum or at another level in the phone system but 
expect, since these were automated messages, that might have triggered the caller id designation.  
 
For what I knew were valid calls, saved the phone number on my phone's Phonebook and changed the 
name from SPAM RISK to a more recognizable name. 
 
Place icon on desktop of one or select users (Windows) 
If there are multiple user accounts on computer, adding a shortcut to one Desktop often adds it to every 
user’s desktop. It is possible to add the shortcut for specific users only.  
 
Shortcuts on the Desktop are displayed from two Desktop folders, public and user specific. 
 
Log on to one user account. Check C:\Users\Public\Desktop folder (hidden folder so need to enable 
Hidden Items under View tab). Move all shortcuts you want to be shown only on that user’s desktop to the 
personal desktop folder: C:\Users\This_Username\Desktop. (Where This_Username) is the name of the 
user account logged into.  
 
Log on to other user accounts and do the same for shortcuts you only want to be shown on other user  
desktop. 
 
If you have more than two user accounts and want a shortcut on more than one user’s desktop, copy 
shortcut from Public\Desktop to the first user(s) and move to the last user.  
 
 

https://community.norton.com/en/forums/norton-antivirus-scam
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Print list of files from Windows File Explorer  
Print only the list in the folder (shows sub-folders but not the files in the sub-folders): 
Open folder, press Ctrl + A to select all files 
On the Home Ribbon, click Copy Path 
Open document or spreadsheet and Paste  
 
To create list of all files in a folder (including those in sub-folders): 
Navigate to folder 
In Address bar of File Explorer, type cmd and press Enter to open Command Prompt in that folder 
Paste or type following command into Command Prompt and press Enter 
dir /a /s /b > filelist.txt 
When command completes, to close Command Prompt, type: exit and press Enter 
In the folder, locate the file: filelist.txt. That file will contain a complete listing of all files. 
 
Read Mode in Microsoft Word is designed for reading vs. editing documents as it shows more text on 
the screen. It is more useful on tablet where space is limited.  The explanation says enabling Read Mode 
applies to the current document but it enables it for all Word documents. 
 
With a Word document open, click View tab, then click Read Mode (Default View is Print Layout) 
 
While in Read Mode there is a menu bar across the top 
on the left  File    Tools    View    
 
 
on the right    Auto-Hide Reading Toolbar    Min     Max    Close   
 
To exit Read Mode 
click View then click Edit Document 
or 
click Esc key 
 
Can also enable/exit Read Mode using icons on lower right of document 

 
 
 

Enable Read Mode: click book icon (two pages like open book)   
 
Exit Read Mode: click Print Layout icon (single page) 
 
For more information about Read Mode: 

https://www.howtogeek.com/217739/HOW-TO-CUSTOMIZE-AND-USE-THE-READ-MODE-IN-WORD/  
 
Set Password Expiration for users on Windows 10 Home 
Using an elevated command prompt can enter commands to require a local user account to change logon 
password after specified number of days. Can also change number of days before password has to be 
changed (default is 42). Anyone with Admin access can enable Password Expiration for any or all user(s). 
Number of days applies to all users who have Password Expiration enabled.  
 
Someone logging in with Microsoft Account, can enable/disable password expiration for that account by 
logging into their Microsoft Account on the web and adjusting the settings there.  
 
https://www.tenforums.com/tutorials/87379-enable-disable-password-expiration-local-accounts-windows-
10-a.html 
 
 
 

https://www.howtogeek.com/217739/HOW-TO-CUSTOMIZE-AND-USE-THE-READ-MODE-IN-WORD/
https://www.tenforums.com/tutorials/87379-enable-disable-password-expiration-local-accounts-windows-10-a.html
https://www.tenforums.com/tutorials/87379-enable-disable-password-expiration-local-accounts-windows-10-a.html
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Copy Text Messages from Android to PC 
Got different phone. Transferred messages from old to new phone using TracFone Transfer Wizard. Have 
used this in the past with no issue. This time, not all text conversations were transferred and many of the 
text images were missing. On new phone images in Messages only seemed to go back to mid-August 
2021 but they are all on the old phone. A large number of  images from text messages showed up on new 
phone in Photos app under mms.sync.attachments but no way to connect the images to specific 
messages. 
 
Didn't need all text messages on new phone but didn't want to lose them so looked for a program that 
would allow saving text messages with images to the PC. There were several available. 
 
Droid Transfer from Wide Angle Software installs on PC and companion app, Transfer Companion, 
installs on phone. Was easy to set up. Transferred messages from old phone to PC wirelessly. Could 
have connected via USB cable. Used trial version (five messages per conversation) to test before 
purchasing perpetual license for $30.  
 
The app also works with Music, Photos, Calendars, Contacts, Call Logs, Files and Apps but haven't tried 
working with any of those categories.  
 
Messages are displayed by conversation. Can chose which conversations to save.  A few conversations 
from old phone were not listed in Droid Transfer and some conversations were listed but when I tried to 
display the contents, it indicated the messages could not be found. These were short conversations and 
not ones that I wanted to keep anyway. 
 
In Droid Transfer, options for saving include Save as PDF, Save as HTML and Save as Text. Saving as 
PDF saves all text/images in single PDF file. Save as HTML creates one file (with HTML extension) and 
one folder containing Message Attachments (Images). Clicking on HTML Extension file shows both the 
text and images in message sequence. Clicking on Message Attachments folder shows all the images as 
individual files which can then be shared, printed, etc.  
 
All except one conversation saved as PDF, but all saved as HTML. Indicated the PDF file had been 
created but it didn't appear in the folder. Tried multiple times, saving to different locations, exiting out of 
program, shutting phone down and restarting. This wasn't the largest conversation on the phone so 
figured it wasn't a size issue so must be something corrupt in the conversation. Another feature of the 
program is to select by date range. Saved each year to PDF, starting in 2014, and all except 2020 saved. 
Worked with quarters in 2020 and the first quarter, Jan-Mar didn't save. By narrowing the date range, 
determined that the issue was with a specific date, March 29, 2020. Closed out of Droid Transfer and 
went into the Message app on old phone and deleted some images from March 29  but still wasn't able to 
save that date. Since text and images from March 29, 2020 were in the HTML file, decided not to pursue 
further. For that conversation, saved two pdf files, one from Jan 1, 2014 to March 28, 2020 and the other 
from March 30, 2020 to December 31, 2021.  
 
Have used the Transfer Wizard each time I get a new TracFone. It appears that Transfer Wizard stores 
some files, e.g., Pictures. under a Transfer Wizard folder. That folder contains sub-folders also called 
Transfer Wizard with Pictures (from previous phones?). Regardless of which folder/sub-folder saved in, all 
pictures correctly display in Photos app under date taken. This time, instead of transferring pictures using 
Transfer Wizard, copied them directly from phone to PC since I had no need to keep them all on the new 
phone but wasn't ready to delete them.  In the past, I have not sync'd my phone to Google Photos, so any 
pictures taken on phone, were only on phone. For now am sync'ing new phone with Google photos and 
any old pictures I want to appear on phone, have uploaded from PC  to Google Photos. 
 
Set up Windows 11 without a Microsoft Account 
Have not set up Windows 11 on new computer so don’t know if any of these options work. When updating 
from Windows 10 to Windows 11, the existing userids worked whether local or Microsoft Account.  
 
https://www.xda-developers.com/windows-11-microsoft-local-account/  (June 6, 2021) 
 

https://www.xda-developers.com/windows-11-microsoft-local-account/
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https://winaero.com/how-to-install-windows-11-with-local-account/  (June 19, 2021) 
 
https://www.neowin.net/news/windows-11-home-requires-internet-to-complete-setup-but-there039s-a-workaround/ 
(June 19, 2021) 
https://fossbytes.com/create-local-account-windows/ (September 1, 2021) 
 
Opinion - June 25, 2021 
https://www.extremetech.com/computing/324134-i-will-never-use-a-microsoft-account-to-log-into-my-own-pc   

 
Program to download YouTube videos 
Had initially set someone up to use ClipGrab to download YouTube videos but that programs stopped 
working. Found the following site with multiple programs for different needs. The individual was only 
interested in audio/music so was able to use free program.  
 
Check out: Full list of applications by MediaHuman  
 
Music only - YouTube to MP3 converter 
Free 
 
----------------------------------------- 
 
For videos - YouTube Downloader 
Free trial for 20 downloads and then $19.99 to purchase, additional cost for lifetime updates. 
Have not tried this program. 
 

 
 

COMPLETE ROBOCALL DETERRENCE 
A two-step approach: prevent the ring and convince the robocaller that your line is disconnected. 
Part 2 of a three-part article series 
By John Krout, Presenter & Newsletter Contributor  
Potomac Area Technology and Computer Society 
https://www.patacs.org  -  jkrout.apcug.presenter (at) gmail.com 
 
INTRODUCTION 
 
In Part 1 of this series, you learned how to configure your smartphone so that only your Contacts will ring 
your phone, a Whitelist strategy.  
 
That Whitelist solution is not complete because robocaller systems can still find out that your phone is 
live simply by recognizing that the call went to your voicemail. And you continue to suffer the frequent 
voicemail inbox overload syndrome since many robocallers leave voicemails. 
 
This part 2 article introduces the concept of including the Special Information Tones (SIT). The three 
tones beginning phone network messages, such as the number you dialed, are disconnected at the start 
of your voicemail greeting. After SIT, you can include your voice telling your Contacts that your number is 
indeed live, not disconnected, and they can leave a message. 
 
WHY SIT? 
 
Robocaller systems, like any valuable asset, are focused on the efficient use of system time. So each 
robocaller system maintains an internal list of phone numbers known to be valid.  
 
How can robocaller systems determine that a called number is not valid? When the phone number is 
disconnected, i.e., the system hears SIT. When robocaller systems hear SIT, the systems remove the 
number from their internal list of numbers known to be valid. Then, they don’t call again. 
 

https://winaero.com/how-to-install-windows-11-with-local-account/
https://www.neowin.net/news/windows-11-home-requires-internet-to-complete-setup-but-there039s-a-workaround/
https://fossbytes.com/create-local-account-windows/
https://www.extremetech.com/computing/324134-i-will-never-use-a-microsoft-account-to-log-into-my-own-pc
https://www.mediahuman.com/products.html
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The proof is in the pudding, as some say. In September 2019, I was receiving about 25 robocalls per 
week and roughly ten robocall voicemails per week. I implemented this SIT voicemail greeting strategy in 
July 2020. Between that time and March 2021, when I wrote this article, I typically received only two 
robocalls per week in Missed Calls, and my weekly robocall voicemails dropped to zero.  
 
Why do I still receive any robocalls? First, because there are hundreds or perhaps thousands of robocall 
systems, some systems have yet to call and hear SIT. 
 
CARRIER OPTIONS FOR VOICEMAIL GREETINGS 
 
Typically, phone carrier companies, such as Verizon Wireless, AT&T, and T Mobil, offer three different 
ways to create a voicemail greeting. 
 

Automatically state your phone number, for instance: You have reached 703-555-1111. 
Please leave a message after the beep. 

 
Play a recording of you pronouncing your name, for instance: You have reached the 

phone of John Krout. Please leave a message after the beep. 
 
Play a recording of whatever you want to say for your greeting. 

 
So, our strategy will be to use the third option, a recording, to make robocaller systems think your phone 
line is disconnected. Most phones expect you to use the phone’s microphone and your own voice to 
record that voicemail greeting.  
 
Below, I will show you how to combine SIT and your greeting on your computer. Then, in Part 3 of this 
article series, I will show you three ways to transfer that combined audio into your phone for use as a 
voicemail greeting. 
 
HOW TO GET SIT 
 
There are websites that curate phone network messages. I downloaded a couple of those messages and 
used the free Audacity sound editor to isolate SIT and remove audio noise. 
 
I have posted that cleaned-up SIT online as a monophonic WAV file on the Web. You can download it 
from: 
 
https://tinyurl.com/6n5hyb6d 
 
MAKE YOUR GREETING SCRIPT 
 
Before recording, I suggest you type your voicemail greeting script in a document in a large font, so you 
can read it easily while recording. 
 
Here’s what I used as a script: 
 
Hi, this is John. No, my number is not disconnected. Those tones were just meant to convince 
robocallers not to call me again. You can leave a message after the beep. Thanks. 
 
RECORDING YOUR VOICE 
 
No matter how you record, the phone 
carriers require that your custom 
voicemail greeting has to be 
monophonic, not stereo. You can 
either record monophonic or use 
Audacity to reduce the recording from 
stereo to monophonic. 

Illustration 1 

https://tinyurl.com/6n5hyb6d
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One convenient way to record your voice 
is to use a voice recording app on your 
phone and then transfer that digital 
greeting audio file to the computer. 
Android users can download any of 
several voice recording apps from the 
Google Play Store. Ensure the app 
documents the phone folder in which you 
can find the digital audio recording file for 
transfer to your computer. For example, 
iPhone users can find the Voice Memos 
app in the Accessories folder. Recordings 
can be transferred to the computer using 
iTunes sync. 
 
Alternatively, if you obtained a computer microphone for virtual online 
meetings during the pandemic, or your laptop has a built-in microphone, 
you can record your voice directly to your computer using an application 

such as the frees Audacity audio editor. 
 
COMBINE SIT AND YOUR VOICE RECORDING 
 
Audacity provides a convenient multi-track method for doing this task. 
 
STEP 1. Open Audacity, pull down the File menu and select Open. Then, 
using the standard Open File dialog box, load the SIT recording. After you 
do that, the oscilloscope-like depiction of the SIT recording appears in an 
Audacity track, like that shown in Illustration 1. 
 
STEP 2. In Audacity, pull down the File menu and select Import. Then, 
using the standard Open file dialog box, load the voicemail greeting 
recording. 
 
Audacity places that imported voicemail 
greeting recording in a second track, below 
the track that contains the SIT recording. 
You can see an example in Illustration 2. 
Audacity adjusts the time scale so that the 
longer track is completely visible. 
 
However, both audio recordings start at the 
same time. Therefore, we need to move the 
voicemail greeting recording to the right to 
start after SIT ends. Here is how to that 
happen. 
 
 
 
 
 
 

Illustration 4 

Illustration 3 

Illustratiion 2 
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STEP 3. In the second track, click at the time 
point where SIT ends. A black vertical cursor 
will appear in the second track. Again, you 
can see an example in Illustration 3. In that 
illustration, the vertical cursor is circled. 
 
STEP 4. Pull down the Tracks menu. In that 
menu, select Align Tracks. 
 
A sub-menu appears. In that sub-menu select 
Start to Cursor/Selection Start. This choice 
means that the track in which the cursor 
appears will be moved to the right so that the 
audio starts at the cursor. 
 
You can see the menus and choices in 
Illustration 4. 
 
Audacity moves the voicemail greetings in the 
second track to the right, to the point where 
you set the cursor. You can see an example in 
Illustration 5. 
 
 
At this point, your custom ringtone is ready to be auditioned. The play controls in Audacity look like CD 
player or MP3 player controls, including a Start at Beginning button, a left-pointing black triangle with a 
vertical black bar, and a green triangular Play button. Those buttons appear in Illustration 5, just below 
the Audacity main menu bar where File and Tracks appear. 
 
Click Start at Beginning and then Play. If you like the result, I strongly suggest you pull down the File 
menu and Export the result to a WAV file as a backup. 
 
If you do not already have Audacity installed on your computer, here is the download link: 
 
https://www.audacityteam.org/download/ 
 
NEXT UP 
 
In part 3 of this article series, you will learn how to transfer that combined greeting audio to your phone 
for recording as a voicemail greeting. 
 
ABOUT THE AUTHOR: John Krout has been writing about creative uses of personal computers since the 
early 1980s, and more recently, about creative uses of smartphones. He finished a long career as a 
software engineer with 14 years as a technical writer for a federal contractor. He lives in Arlington, 
Virginia, with his son, many computers and cameras, and too many cats. 
 
 

First Look at GNOME 40 Desktop 
By Cal Esneault, Cajun Clickers Past President and leader of many Open-Source Workshops & SIGs 
June 2021 issue, CCCC Computer News—www.clickers.org—office (at) clickers.org 
 
The GNOME 3.x desktop has been a favorite for many Linux distributions. Recently, the GNOME Project 
updated its toolkit series from the GTK 3.x family to the new GTK 4.x series. New desktops concurrent 
with this upgrade will now be numbered differently, starting with GNOME 40 as the initial offering. I made 
a quick comparison of GNOME 3.36 (from Ubuntu 20.04 LTS) to GNOME 40.0 (from Fedora 34).  
 

Illustration 5 

https://www.audacityteam.org/download/
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The GNOME 3.x paradigm emphasized panels and virtual workspaces located on the sides of the screen 
(see below). Since most computer monitors are wide (for example,16:10 ratio), this gives more working 
area for the actual application. Because most designs traditionally used horizontal panels (top or bottom), 
this required some break-in effort, but, overall, it has been effective and accepted by many. 

 
 
GNOME 40 has reverted to a more horizontal layout (see next column), with launcher panel being 
centered at the bottom (more like Mac OS design). In “Activity” view, the adjacent workspaces are visible 
and easily scroll left and right in a very natural motion. There are also workspace thumbnail icons at the 
top for quick access. 

 
 
The GNOME 40 program launcher has the same icon grid view as the previous series. However, images 
for the virtual workspaces are also displayed above the grid (see below). 
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This allows the user to drag an application to any desired workspace to launch it. My previous approach 
had always been to go to the desired workspace first and then launch the app. This looks like a fast and 
intuitive solution to a common action.  
 
Of course, this summary does not do justice to a major desktop upgrade, but I wanted to see the new 
layout for myself since I had heard it was quite different. It looks interesting, and I will eagerly await the 
adoption of this change when it arrives for one of the distro’s I normally use (note: due to the recency of 
this desktop, some distro’s have not had time to incorporate it at this time) 
 

 
 

 
 

Having Fun Making Lists 
By Dorothy Fitch, Editor, GVR Computer Club 
March 2021 issue, Green Bytes—https://www.ccgvaz.org/ - dmfitch (at) cox.net 
  
I am an inveterate list maker. I've always made lots of lists and during the pandemic, I seem to be making 
more and more—probably because I have additional time on my hands. Some people might dread lists, 
thinking only of "to do" lists, which can, I admit, be daunting. However, I enjoy making lists and find them 
indispensable. 
 
What types of lists do I make, what tools do I use to make them, what are the tips I have discovered? 
Read on for some answers. 
 
Grocery Lists > using phone apps + paper 
 

I'm a fan of the Safeway app on my phone. I make a list of items I want to purchase using 
it. (I found I can no longer add custom items to my list on the Safeway website.) While 
shopping, I click each item when I've put it in the cart. This lets me see what I still need to 
get. Occasionally I find "Just for You" deals at the store that I hadn't noticed at home, and I 
can add them. With fewer miles driven, we use our Rewards for dollars off our groceries. 
Using 7 Rewards for $10 off is a better deal for us than gas discounts (especially with our 
Prius). 

 
For trips to Costco, I sometimes use a simple text editor (Samsung Notes) on my phone, where I enter the 
items we typically purchase there. More often, I bring along a scribbled list on a scrap of paper. 
 
Backyard Bird List > using a spreadsheet + paper 
 
We post a legal-sized sheet of paper on our refrigerator door where we mark every species of bird or 
other wildlife we see or hear every day. I created the list in Excel, and add new species to it as needed. I 
print a new list at the beginning of each month. For a long time, I transferred the data back into the 
spreadsheet after the month was over, but that was time-consuming. I could be using the eBird app, but 
our low-tech system is more easily accessible to both of us. It's also easier to look at the paper sheets to 
find out when the White-crowned Sparrows have headed north for the summer in prior years and when 
the White-winged Doves are likely to return in force. 
 

https://play.google.com/store/apps/details?id=edu.cornell.birds.ebird&hl=en_US&gl=US
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Lists of Authors' Books, in Order > using Word 
 
My husband and I read lots of books. We try to keep track of the books we have read (though I've found I 
can reread the same book within a year and not remember it...). To get a list of an author's books in the 
order written, just search the web for a phrase like "JA Jance books in order". Copy and paste that list into 
Word, print it, and check off the titles as you read them. 
 
Lists of Television Episodes > using Notepad + Word 
 
Because our DVR's season pass for "Iron Chef America" was bringing in only episodes we'd seen (some 
multiple times), we decided to try "Chopped." Yes, we're a little late to that party (the show started in 
2007). To check off episodes we've seen, I  decided (naturally) to make a list. I found various websites 
listing "Chopped" episodes, but some had too much information (such as the winners). I like this website, 
which I can sort by season or year. I tried copying the list for a particular year and pasting it into Word, but 
that created issues: some of the content had active links and things that turned into checkboxes. When I 
tried to delete them, Word hung. So instead, I pasted the text into Notepad, a simple Windows text editor 
that removes all formatting and links. Then I could copy that text and paste it into Word. After a small 
amount of formatting, I was done and happy with the result. Let the cooking begin! 
 
Opera Lists > using Excel 
 
We are opera fans and keep track of the operas we have seen. We've watched many of the daily 
streaming operas offered by NYC's Metropolitan Opera. We have seen some operas many times now, 
often with different casts and productions set in different eras or locales (Verdi's Rigoletto set in 1960s 
Las Vegas actually worked very well!). We keep track of all the operas in an Excel spreadsheet. The list is 
sorted by composer, which I mark with an 'X' at the first occurrence. I also keep track of the number of 
different versions we have seen of the same opera. Some of the formulas I have found useful are these 
(they also work in Google Sheets): 

• =SUM(A2:A300) — returns the sum of all numbers in the specified range 

• =COUNTIF(B2:B300,"X") — returns the number of cells within the specified range that contain "X" 

• =COUNTBLANK(C2:C300) — returns the number of cells in the range that are blank 
There are dozens of formulas and functions you can use in Excel. Click on the Formulas tab in Excel, 
where they are sorted by category, or click here for a complete list. 
  
Shared Lists > using Google Sheets 
 
As workshop facilitators for nearly all of Tucson Audubon's annual birding festivals over the last 10 years, 
my husband and I have had to keep track of a lot of information. The festival chair set up a shared Google 
Sheets file (Google's version of Excel) so we could all access and edit the content stored there. It worked 
wonderfully and I have since created shared Sheets for other organizations. 
 

To create a shared Sheet you need a Google account (i.e., Gmail 
address). Log in to your account and at the upper right of the window, click 
the 9-dot grid, shown at the top of the image at the left. Then scroll down 
and click on Sheets. 
 
Once you have started the spreadsheet, you can click the green Share 
button at the upper right of the window. You can specify individuals to 
gain access to the Sheet by entering their email addresses (Google will 
send them a notification) or copy the link to the spreadsheet. You can 

restrict access to just those you have invited, or allow access to anyone with the link. You can assign 
them Viewer, Commenter, or Editor privileges. The Sheet is always saved automatically regardless of 
who edits it. You can see a Version History of who made edits. 
 
Shared documents (including Google Docs and Calendars) offer a great way to collaborate with others. 
 

https://www.imdb.com/title/tt1353281/episodes
https://www.metopera.org/
https://www.techonthenet.com/excel/formulas/index.php
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Tech Talk: How Computers Look at Lists 
 
To a computer, there are two types of lists: ordered and unordered. 

• An ordered list has numbered items that are in a specific order. 

• An unordered list (like this one) has items in no particular order. This is typically a bulleted list. 
 
Web programmers use different tags for the two types of lists. 
In most web content editors, they can simply choose a numbered or bulleted list as you can in a Word 
document. But, in some cases, web programmers build their own list using HTML tags. 
 
Programmers use <ul> to start an unordered list and </ul> to end it. 
Programmers use <ol> to start an ordered list and </ol> to end it. 
 
Consider a recipe. It typically starts with an unordered list of ingredients, then proceeds to an ordered list 
of step-by-step instructions. If you don't follow the directions in the right sequence, you may not get the 
result you want! 
 
This relatively simple recipe illustrates both types of lists. 
Source: www.self.com/recipe/tomato-poached-cod-with-rice 
 
Tomato-Poached Cod with Rice 
 
INGREDIENTS 

• 2 cod fillets (4 ounces each), skin removed 

• 1 cup jarred tomato sauce 

• Salt 

• Pepper 

• 1 tablespoon olive oil 
1-1/2 cups cooked wild rice 

DIRECTIONS 
1. Heat oven to 400°. 

2. Season fish on both sides with salt and pepper. Drizzle with olive oil. 

3. In a medium skillet, bring the tomato sauce to a boil, then reduce to a simmer. Place fish in skillet and 
use a spoon to cover completely with sauce. Transfer to oven and bake 10 minutes, until fish flakes 
easily. 
4. Warm cooked rice in the microwave or a skillet over medium heat with a little olive oil. Serve fish and 
tomato sauce over rice. 
 
Click to see the HTML code that generates these lists. 
The <li> and </li> tags start and end each 'list item' in both lists. 
 
This article does not cover all the types of lists I make. Someday I hope I'll again make packing lists for 
trips. 
 
Try some of these list ideas and see if they help you stay organized! 
 

 
 

https://www.self.com/recipe/tomato-poached-cod-with-rice
https://mcusercontent.com/fc5b48c8cad5d194a77f4cb54/images/78289091-7645-4d8c-ad66-e4ad2b08aa5f.png
https://mcusercontent.com/fc5b48c8cad5d194a77f4cb54/images/78289091-7645-4d8c-ad66-e4ad2b08aa5f.png
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Windows 10 Tips and Tricks 
By Dorothy Fitch, Editor, GVR Computer Club 
October 2020 issue, Green Byte  -  https://www.ccgvaz.org/ - dmfitch (at) cox.net 

 
Here are some tips and tricks for using Windows 10. Try them out! 
 
1. How to pin items to the Taskbar or Start menu 
 
It can be handy to have your most frequently used apps just a mouse-click away. You can place buttons 
to open or switch to them on the Taskbar that runs along the bottom of your screen, or in the Start menu, 
which is what you see when you click the Windows button at the left edge of the Taskbar. 
 
To put a program in one of these places, click the Start button. Scroll down to find the program you want 
to add in the list. Right-click the name of the program and you will see these choices: 
  

 
 
You can click Pin to Start on the left side to add it to the Start menu. Or you can click Pin to taskbar to 
place it at the bottom of your screen. Either way, you'll have an easy way to get to your programs. 
 
There are probably already shortcut icons on your Desktop to start up your programs, but I find the 
Desktop gets too cluttered and I have hidden all the Desktop items. To do this, right-click anywhere on 
the Desktop. Choose View, at the top, and then uncheck Show desktop items. 
  
2. How to add Search and Task View to the Taskbar 
 
Here are a couple of handy tools you can add to your Taskbar. 
 
A. You can add a Search button or even a Search box. Right-click the Taskbar and look for Search, near 
the top. Your choices are to hide Search, show the icon, or show the text box. 
  

 
 
If you choose the icon, you can click it to get a search box. You can filter the search to include All, Apps, 
Documents, Web, Folders, and more. Select what you want to search by clicking on the desired area. 
 
B. You might also want to add the Task View button. To do this, right-click the Taskbar and select 
the Show Task View button. When you click the Task View button, all of your open files and folders 
appear on your screen and you can click to switch to any of them. 
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The left side of your Taskbar might now look like this, with the Start button first, then the Search button, 
then the Task View button. With these options available, it's easier to get around Windows 10. 
  

 
  
3. Windows 10 Major Update and what I had to correct 
 
Your Windows 10 computer may have just been updated a new version. In mid-September, my new 
version was installed: v. 2004. That sounds like it's about seven years old, but Microsoft names major 
updates after a year and a month, so it is only about five months old (2004 means April 2020). [To find 
your version number for Windows 10, go to Settings > System > About.] 
 
I haven't read anything about this update, but I noticed a couple of differences right away. One was that 
every time a search for something in File Explorer came up empty, my entire screen flashed black, 
inverting most of the colors. It was very momentary, but rather disturbing. I finally figured out where to 
change that setting. 
 
It's under Audio, of all things. I had thought that perhaps I was seeing this screen flash because most of 
the time I have my sound turned off. But even after unmuting my sound, it persisted. I was finally able to 
turn it off by going here: Settings > Ease of Access > Audio. (To get to Settings, click the Windows button, 
then the gear.) 
 
Below is what part of that setting looks like (click to enlarge it). Note the choices at the bottom for Show 
audio alerts visually. I found mine set to Flash the entire screen! I know I never chose that setting and can 
only imagine that Microsoft changed it during the update process. Now, it's back to something better. 
Whew! 
  

 
 
4. How to customize colors and backgrounds 
 
Here is another issue that occurred after that major Windows 10 update. My Taskbar was very light-
colored and all the tabs in my browser were black! That was definitely not what I had before, and I didn't 
like it. I poked around and found the settings needed to put them back to what I wanted. 
 

https://mcusercontent.com/fc5b48c8cad5d194a77f4cb54/images/9b8c0fd0-990d-4f53-990e-35f341fc750b.png
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I found them in Settings > Personalization > Colors. I chose Dark for default Windows mode and Light for 
default app mode. I'm not sure about the terminology being used, but it didn't matter. I was able to click 
the radio buttons and see the colors change immediately, so I knew when I had made the right choices. 
 
You can also choose to have a slideshow of images on your desktop. Go to Settings > Personalization > 
Background to choose a folder to select the images from, set the timing, and explore other options. 
  

     
 
It's fun to change your colors and backgrounds once in a while to give your computer a fresh look. 
 
Note: In Windows 10, you can select just a single folder for background photos. Choosing that folder 
doesn't automatically include images in its subfolders. To enjoy a wider selection of photos, I created a 
new folder and copied a few thousand images into it to be chosen at random for background images. 
  
5. How to restore those fun Windows 7 games 
 
Remember those fun games that came with Windows 7— Mahjong Titans, FreeCell, Minesweeper, 
Hearts, Solitaire, to name a few? You can install these games on Windows 10 and they work just fine. 
However, Microsoft tends to delete them when it does a major update (it just did it with my 2004 update in 
September). Advice: keep the download file so you can always get them back. You can choose which 
games you want to install. 
 
To get the games, click here to go to the website, then click the link shown below. (Note that there are 
several other Download buttons on this page, but they are ads, so stay away from them.) 
 

https://winaero.com/blog/get-windows-7-games-for-windows-10/
https://mcusercontent.com/fc5b48c8cad5d194a77f4cb54/images/c10e6bc0-2159-494d-aca6-6bfbe52b0c68.png
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Then look for and click this link: 
  

     Download 'Windows 7 games for Windows 10' 

     Size: 146.66 Mb 

     Download link: Click here to download the file 

 
6. How to manage multiple documents with checkboxes 
 
You can add checkboxes to items in folders in Windows 10. Click the View tab in any folder and look for 
the Item check boxes option in the Show/hide area (shown circled in red in the image below. 
 
Checking this option puts a check box next to each item in the folder. This may make it easier than using 
the mouse to select several items at once. Then you can copy, delete, or open them in one easy action.  
  

 
  
7. How to use multiple clipboards 
 
Did you know that Windows 10 supports multiple clipboards? After copying text or images, you can 
choose which one you want to paste from a list of recently copied items. First you have to turn on the 
feature. Go to Settings > System > Clipboard. Turn on the button for Clipboard history. 
  

https://winaero.com/downloads/Win7Games4Win10_8_81_v2.zip
https://mcusercontent.com/fc5b48c8cad5d194a77f4cb54/images/bf7d9761-d354-42fd-8593-1448a135328a.png
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Now, when you want to paste an item from your Clipboard history, hold down the Windows key on your 
keyboard (it's between Ctrl and Alt) and press the V key. You will see a list of the things you can paste 
and click on the one you want. 
  

Enjoy exploring some of these Windows 10 features! 
 

 


